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Part 1 — General information

New to taking Technical Safety BC’s exams online?

Technical Safety BC allows you to write exams online with the help of our online
proctoring tool, ProctorTrack. ProctorTrack features various tools to ensure academic
honesty and protect the integrity of certification exams. To do this, it uses video and
audio recordings during your exam session. It also monitors screen and keyboard
activity, taking screenshots of your desktop and detecting the number of monitors you
may be using.

This guide will help you get ready to take your exam. It will explain hardware and
software requirements, and provide everything you need to know so that your exam will
go as smoothly as possible.

Review this guide carefully and avoid surprises on exam day.

Get your hardware ready

Here’s what you need to take your online exam:

o A desktop or laptop computer that you will use for the exam (smart phones or
Chromebooks will not work)
A reliable internet connection
A webcam
A microphone (internal microphone only, headset microphones are not permitted)
A smart phone that you will use to take your picture, show your ID, and record a video
of your room to show it is clear of prohibited items
o The smart phone will be locked and inaccessible once the exam begins

If you don’t have these items in working condition, please call us to reschedule your exam at
1 866 566 7233. You cannot take the exam online without these items.
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Get your software ready

Technical Safety BC uses an online proctoring platform,
ProctorTrack, to deliver your invigilated exam. If you don’t have GD g'E‘: Chrome
these already, you will need to download and install:

s
e Google Chrome or Mozilla Firefox (Internet Explorer and

Safari are not recommended)
e Adobe Reader

Download and install these 3-5 days before your exam. Also test your computer, mic, and
webcam so that they’re ready when exam time comes.

STEP 1: INSTALL RECOMMENDED BROWSER

Our online exams require you to use one of the recommended browsers above. If you don’t
have one already, download and install one from the links below.

Google Chrome for Windows (Recommended)
Google Chrome for Mac (Recommended)
Mozilla Firefox for Windows

Mozilla Firefox for Mac

Upon successful installation, you will be asked if you want to make the installed browser your
Default Browser. Select “yes”.

STEP 2: INSTALL ADOBE READER

During your exam, you may need to view digital information in PDF form. If you don’t have it
already, download Adobe Reader.

STEP 3: INSTALL PROCTORTRACK SOFTWARE IN ADVANCE

You will be asked to install the ProctorTrack software during your exam. You do not need to
install the ProctorTrack software before this time.
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Get yourself ready

IMPORTANT
BEFORE EXAM DAY v
Test your computer,
Set up your exam space webcam, and
Make sure you have a quiet, well-lit place to take microphone before
the exam. Your location needs a reliable internet your exam.

connection. Be sure your room or desk doesn’t
have any personal items visible that you don’t
want to show on camera. Clear the room of any
items that are not allowed.

Familiarize yourself with the exam rules

Technical Safety BC enforces strict exam
protocols to ensure exams are protected from
tampering and cheating. You have been provided
with these rules. Be sure you understand them
and are ready to adhere to them. On exam day,
you will be asked to formally acknowledge and
sign off on these rules.
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ON EXAM DAY

Have your ID ready. You will need one of the following pieces of valid government-
issued picture identification before starting the exam:

e Driver’s licence, Canadian citizenship card, Passport, BC ID or BC Services
card, Indian Status card, or Fire Arms Card

You should use the same ID that you used to apply for the exam. There is a possibility
that we may request second piece of identification on the day of your exam, so it'’s a
good idea to have two pieces of valid ID on hand.

Important: The information on your ID must match the information you provided on
your application.

Double check your set-up. Ensure your hardware and software are ready and your
room is set up properly. Review the exam rules one more time to be sure you
understand what you can and cannot do.

TIPS
Start your exam. v Close all other tabs in
1. Be sure you have an appropriate room Chrome and all other
set-up. computer applications.
2. Click on the access link, and log in using v Disable other devices in

the username and password in your
confirmation email.

3. Follow the instructions provided on screen
to access your exam, set up ProctorTrack,

your household that have
screencasting features
(e.g., Apple TV, Amazon

FireStick).
and take your exam.
a. The ProctorTrack set-up process is v Silence pop-up
demonstrated in Part 2 of this notifications on your
guide. Take a look to know what to computer.

expect.
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Readiness checklist

Use the checklist below as a guide to prepare you for your exam.

HADRWARE

O O O O O

Get access to laptop or desktop
Ensure reliable Internet connection
Set up webcam

Set up microphone

Bring smart phone

SOFTWARE

O O O

Download and install recommended browser
Download and install Adobe Reader

Run checks on webcam and microphone

EXAM READINESS

O O O o o

Review Exam Rules thoroughly

Review Frequently-Asked-Questions (FAQS)

Prepare room set-up, removing all prohibited items
Know how to get help before, during, and after the exam

Get your ID ready (using the same ID as your application)

1 866 566 7233


https://webcamtests.com/
https://www.onlinemictest.com/

@ TECHNICAL SAFETY BC
Frequently asked questions (FAQS)

Who to contact for help

1. I need help with computer set-up, including issues downloading a
recommended browser, and getting my microphone and webcam to work. Who
do | contact?

ProctorTrack provides technical support for the online exam set-up. They can be
contacted at https://www.proctortrack.com/support/.

2. Who will help me if | experience technical issues during my exam?
ProctorTrack provides live technical support while exams are in progress. To access

live support during the exam, click on the chat icon in the top left-hand corner of
the lower right pop-up window, and click the icon. If you don’t see the lower right
pop-up window, you can maximize it by clicking on the dash icon =.

relaunching the app?

Aarrir Joe 1 30FM

Hi, my app crashed, could you please halp me
wnderstand what's happening?

| am soery 1o hear that, have you tried

Yiou 1:30P8

3. Il have other questions related to taking online exams. Who do | contact?
For any other additional support required, call us at 1 866 566 7233.

Note that both ProctorTrack and our Contact Centre may not be able to support you
immediately. It may take time for either support team to respond to you. The time
spent resolving technical issues will not impact the total amount of exam time you
have. Be assured that you will be given the full amount of time to take your exam.
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Taking an exam online

1. What is ProctorTrack?

ProctorTrack allows you to write exams online. It features various tools to ensure
academic honesty. To do this, ProctorTrack uses video and audio recordings during
your exam session. It also monitors screen and keyboard activity, taking screenshots
of your desktop and detecting the number of monitors you may be using. Web traffic
may also be recorded during your exam. If there are any instances of concern,
ProctorTrack will report them to Technical Safety BC. The data is only collected
during the exam period and may be reviewed by Technical Safety BC employees
afterwards to ensure you comply with the exam rules.

2. What if I lose connectivity or get kicked out of the exam?
If you are removed from your exam, wait for connectivity to resume. Then, close all
applications and windows. Navigate back to the exam from the link provided to you,
just as you did when you initially began the exam. You will be able to continue from
where you left off. If the problem persists and you cannot continue, call us
immediately at 1 866 566 7233.

3. Will someone be watching me during my exam?
There is no live invigilator watching you write the exam but you will be recorded.
Technical Safety BC employees will access these recordings afterwards to verify
your compliance with the rules.

4. What about my privacy?
Online exams are recorded so that we may verify academic honesty afterwards.
Information captured during the exam for review purposes may include:
¢ Real-time video and audio recordings of the examinee and their activities
(including surrounding environment) during the exam session
e Screenshots of the examinee’s computer desktop during the exam session
e Detection of the number of computer monitors connected to the examinee’s
computer
e Records of attempts to execute other routines or processes, such as opening
additional browser tabs

Please be advised that support staff conducting the ID verification and live e-
proctoring are located outside of Canada and your personal information will be
temporarily accessed and stored outside of Canada. Any personal information
collected is handled in accordance with the British Columbia Freedom of
Information and Protection of Privacy Act. The proctored sessions are authorized
under the authority of section 26(c) of FIPPA. If you have questions about the
collection, use, or disclosure of this information, contact the Records, Information
and Privacy Senior Analyst for Technical Safety BC at 1 866 566 7233.
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5. What if | need to use the washroom?
You are allowed to leave the room one time during the exam to use the washroom,
for five minutes. If you are away longer than five minutes, this will result in a breach
of the exam room rules and an automatic fail.

For any special accomodation requests, please contact us to discuss options:
technicalsafetybc.ca/contact-us.

6. What technological requirements are needed to take my exam online?
You will need a desktop or laptop computer that has a working camera and
microphone. Note that only internal microphones are allowed. Headset microphones
are not permmitted. You will also need access to a reliable internet connection.
Finally, you will need a smart phone to perform an ID check and room scan during
the exam authentication process. Be sure you have these items in working order
before registering for the online exam.

Here is a summary of the technological requirements:

OPERATING SYSTEM MAC: macOS Sierra 10.12 or higher, PC: Windows 7, 8, or higher

PROCESSOR/RAM MAC: Intel / AMD Processor, 8 GB RAM, PC: Dual-core 2.4 Ghz CPU, 8 GB RAM or better
RECOMMENDED WEB BROWSERS Mozilla Firefox v20.0 or Higher Google Chrome v25.0 or higher

PLUG-INS Javascript Enabled & Third Party Cookies Enabled

CAMERA RESOLUTION 800 x 600 resolution or better

INTERNET CONNECTION Cable Modem, DSL or better (300 kbps download, 250 kbps upload)

7. How can | avoid problems during my exam?
Here are more tips for a smooth exam experience:

e Pop-up notifications: Turn off any notifications from your computer and
internet browsers such as Facebook, Facetime, or any other services (for
Mac, use Do Not Disturb settings)

e Screencasting Devices: Turn off/unplug any devices that have
screencasting features, such as Apple TV or Amazon FireStick, because
ProctorTrack will identify these devices during set-up and ask you to disable
them

e Automatic updates: Turn off any programs that may update themselves
automatically and attempt to notify you by opening a new window

8. Who determines if there is a violation of exam security protocol?
All suspicious activity is flagged by ProctorTrack for review by Technical Safety BC
invigilators. Technical Safety BC will determine whether or not there is concern
regarding your exam’s circumstances.

1 866 566 7233
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9. What happens if | have to leave my screen for reasons beyond my control,
such as an emergency? Will | automatically fail my exam?
During the exam, you are not allowed to leave the view of the webcam (with the
exception of a five-minute washroom break). If an emergency were to occur that
causes you to have to leave your exam, if you are able, verbally state what the
emergency is, and we will contact you on a case by case basis to review the
emergency and determine next steps.

10. Am | allowed to access this guide, either digitally or in printed form, during the
exam period?
No. Due to ProctorTrack’s exam security settings, you will not be able to access this
guide digitally during the exam. Familiarize yourself thoroughly with the information
in this guide ahead of time so that you do not require it during the exam.
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During the exam

1. What should I bring to the exam?

e Bring a valid piece of government-issued ID. Failure to present an acceptable

form of identification will invalidate your exam. Please ensure your ID for
authentification matches the information you provided on your application.

e You are allowed to bring your own reference material and use four blank sheets

of paper for notes and calculations. You can also access Acts, Regulations,
Directives, and Information Bulletins during your exam. Allowable reference

material varies by technology. Refer to
https://www.technicalsafetybc.ca/certification/exam-information/permitted-
reference-materials for details. Code books are not provided.

e Your own personal scientific calculator, if needed for your exam.
Programmable calculators are not allowed.

No other materials are permitted.

2. Can | write on scrap paper or my own notebook during the exam?

Notebooks are not permitted. You are allowed to use four blank sheets of paper for

notes and calculations, and you cannot write down the exam questions.

3. Can | use Excel or other computer software during the exam?

No. ProctorTrack prohibits anything on your screen other than the exam. This is to

ensure academic honesty. If you attempt to access other screens, you will be
prompted to stop doing so, and a flag will be recorded in your proctoring record.

After the exam

1. Whatdo ldoif I feel | am wrongly accused of cheating, or believe my exam
mark is not accurate?
You can request a review. You will have 30 days from the time you received your
exam results to file a request for a Safety Manager Review. See more details.

2. When will | get my exam results?
Exam results will be provided in writing by mail or email within eight weeks. Exam
results will not be provided by phone, or over the counter at our offices. If needed,
you can contact us by filling out a contact form: technicalsafetybc.ca/contact-
us/contact-form.

3. How long it will take for me to receive my wallet card?

Provided that you have submitted all required documents, wallet cards will be mailed

out within four weeks of your exam being marked. Wallet cards are subject to
Canada Post delivery times.

4. How do I make sure Technical Safety BC has my correct contact information,

such as my address?

If you are unsure about the address we have on file for you, or whether we have all

your required documentation, please fill out a contact form:

technicalsafetybc.ca/contact-us/contact-form. This will avoid any unnecessary delays

in your receiving your wallet card or other documents distributed by mail.

1 866 566 7233


https://www.technicalsafetybc.ca/certification/exam-information/permitted-reference-materials
https://www.technicalsafetybc.ca/certification/exam-information/permitted-reference-materials
https://www.technicalsafetybc.ca/certification
https://www.technicalsafetybc.ca/contact-us/contact-form
https://www.technicalsafetybc.ca/contact-us/contact-form
https://www.technicalsafetybc.ca/contact-us/contact-form

@ TECHNICAL SAFETYBC

Technical troubleshooting

1. Where can I download what | need for taking exams online?

e Chrome browser download for Windows: Google Chrome for Windows
Firefox browser download for Windows: Mozilla Firefox for Windows
Chrome browser download for Mac: Google Chrome for Mac
Mozilla browser download for Mac: Mozilla Firefox for Mac
Adobe Reader download: https://get.adobe.com/reader/

For further details, see:

o Chrome Webcam/Microphone Permissions:
https://support.google.com/chrome/answer/2693767?co=GENIE.Platform
%3DDesktop&hl=en

o Chrome Browser History and Cache:
https://support.google.com/accounts/answer/32050?co=GENIE.Platform
%3DDesktop&hl=en

2. | am getting a message that | don’t have enough RAM. What do | do?
If you get this message, the best way to resolve it is to contact ProctorTrack Support
immediately.
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Part 2 — ProctorTrack Set-up
Instructions

The following instructions will assist you in going through the process of taking a
proctored exam with Proctortrack. If you have any additional questions, you can call
1 844 753 2020 or visit www.proctortrack.com for additional information and live
chat.

The following set-up process creates your profile in Proctortrack and gives you the
opportunity to make sure everything is working correctly. It also gives you time to
make any changes to your system before you start your exam.

Note that examinees can fail the ProctorTrack set-up for the following reasons:

Missing or insufficient facial scan
Missing or insufficient ID scan

ID scan shows invalid ID
Insufficient environment lighting

If you fail the set-up process, you will receive a notification listing the specific
reasons for failure. You will then be asked to retake it.

The following sections will provide steps on how to attempt a proctored exam using
Proctortrack so you know what to expect on exam day.

IMPORTANT: Screenshots and directions may be slightly different based on the
browser and operating system you are using. These instructions were created using
a Windows operating system and Google Chrome.

1 866 566 7233


http://www.proctortrack.com/

@ TECHNICAL SAFETYBC

Accessing the exam in the system

1. From the link provided in your certification email, log in to the exam system
by entering the username and password provided to you. Then, click Login.

Technical Safety BC

Employee Login

Exam Login

Username *

Password *

1 866 566 7233
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2. Click on the exam name.

= TSBC Certification-QA Test Student (test@fake_email.ca) ~

@ TECHNICAL SAFETYBC

My Exams

EL-AFSR-A-1.0NL - FSR Class A

My examinations

“ EL-AFSR-A-1.ONL FSR Class A

All courses

1 866 566 7233
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3. Click on your exam name.

= {STISEMEAL  TSBC Certification-QA Test Student (test@fake_emailcal ~

FSR Class A

Home / My examinations / EL-AFSR-A-1.0NL

Exam Your progress @

Proctortrack cybersecurity incident

On October 14, 2020, Proctortrack, our remote proctoring online exam service provider, notified us of a cybersecurity breach.
Clients impacted by the disruption in service were immediately notified by phone and email. Technical Safety BC has since
received confirmation that none of its clients’ data was compromised. Further information about the incident is available on
ProctorTrack’s website.

At Technical Safety BC, the privacy and security of our client data are of utmost importance to us and we continue to be vigilant
in safeguarding their information. For any questions or concerns about our privacy practices, please contact the Records,
Information and Privacy Analyst at 1 866 566 7233 or foi@technicalsafetybc.ca or take a look at our privacy policy.

i Class A Field Safety Representative - ONL I O
Survey
34 Exam Survey 2021.1 O

4. Read the instructions and click on Attempt exam.

= @ TEEHWEAY  TSBC Certification-QA Test Student (test@fake_email.ca) ~

FSR Class A

Home / My examinations / EL-AFSR-A-1.0NL / Exam / Class A Field Safety Representative - ONL (Fake)

Class A Field Safety Representative - ONL

Class A Field Safety Representative - ONL

Electrical Certification — Operations & Service Excellence
Field Safety Representative
Certificate of Qualification Examination
Class "A" FSR Exam: EL-FSR-A

Online
Based on the 24th Edition, 2018 BC Electrical Code. Adopted Jan 1st, 2020

1. Be sure you are attempting the correct exam

2. Ensure that you are alone in a quiet, secure room and that there are no interruption

while you are attempting the exam

Attempts allowed: 1
To attempt this exam you need to know the exam password

Time limit: 3 hours 30 mins

Attempt exam now

Jump to... s Exam Survey 2021.1 =
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Launching the ProctorTrack dashboard and the ProctorTrack plugin

1. Click Go to my dashboard

Start attempt [x]

| Verificient Proctoring Platform

| Quiz passcode will be made available after verification on verificient's platform

<© Proctor

Click the button below to launch the Proctortrack Dashboard and acce

Go to my dashboard

Contact Us

Timed exam

The exam has a time limit of 4 hours. Time will count down from the moment you start your attempt and you

must submit before it expires. Are you sure that you wish to start now?

2. On the Proctortrack Dashboard, click on the Go To Test button for the test you

would like to attempt.

Upload Status

Test List Onboarding Data

Test Name »

Exam name

Total Tests: 1 OUploaded 1 © Upload Failed 0 Onboarding Status: Passed

Your Onboarding data has been saved.

Passed

Notifications

Status

Date: 06/24/2020

Test
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3. Click Download plugin.

0 pI'O,CI’OI"I’l:a’ckd'” English

<© Proctor

Hi
welcome to new proctoring experience!

integrity realised

Please download and Install the Proctortrack plugin to proceed,
The Proctor Plugin enables your institution to add additional feature.

(\ Download plugin )

4. Click Add to Chrome.

£~ chrome web store £ signin

Home > Extensions > Proctortrack Lockdown Extension

d Proctortrack Lockdown Extension Add to Chrome

Gffered by: Verificient Technologies, Inc

0 | Productivity | & 9,000+ users

QOverview Reviews Support Related

< @ Proctorirack -

Integrity Realized
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Click Add extension.

It can:

n Add "Proctortrack Lockdown Extension™?

Read and change all your data on the websites you visit
Communicate with cooperating websites

Manage your apps, extensions, and themes

You will receive further instructions on the screen. Follow them and then click

Continue.

Lol

© Proctortrack™

The Proctortrack plugin has been successfully installed!
Please follow the four steps below, then click to the “continue” button below.

Click on the Chrome menu at the top right corner.

- o[

In the newly opened Extension page,

find "Proctortrack Lockdown Extension” and click on "Details".

Proctortrack Lockdown Extension

Proctortrack Lockdown Extension

1D
Inspect views background page

English
In the drop down menu, click on More Tools > Extensions.

vrint.. Ltriep

Cast...

Find.. Ctrl-F
Save page a5.. Ctri=5 More tools >
Create shorteut..

£dt Cut Copy  Paste
Clear browsing data... _Ctrl+Shift=Del

Settings
Extensions

Help »
Task manager Shift+Esc

Exit
Developer tools Ctrl+Shifts|

Find "Allow in incognito” and click on the toggle to turn it on.

Allow in incognito

Warning: Google Chrome cannot prevent extensions from D
recording your browsing history. To disable this extension in

incognito mode, unselect this option

v

Technical Safety BC Contact Centre
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Exam familiarization

1. Scroll down and read through the Let’s Get Started section to understand the guidelines

for a proper testing environment.
Let's Get Started

Set Up a Proper Testing Environment for a High Integrity Score.

2. Scroll down further to find the General Guidelines and Instructor’s Guidelines.
These are the guidelines for your exam. Be sure to adhere to them.

General Guidelines

3. After familiarizing yourself with all the guidelines, check the box labeled “I have
read, understand and will adhere to the required environment guidelines”, and
click Go To Next Step.

| have read, understand and will adhere to the required environment guidelines

0 To Next Step

Technical Safety BC Contact Centre
1 866 566 7233
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Downloading and installing the ProctorTrack software

1. Click Download Proctortrack.

Q prOCI'OI' Open Proctortrack?

https://ca-testing.verificient.com wants te open this application.
Pleas
Proct

If you already downloaded the app then...

Step 1. Open the app and click on Connect to Proctortrack button.
e
( Connect to Proctortrack )

Step 2. After that, click anywhere on the app screen to proceed further.

If you do not have the app apduichic.d

loadtban

$tep 1. Click on the Dowrfload Proctortrack button

I ™
(_ Download Proctortrack )

[0 Always allow ca-testing.verificient.com to open links of this type in the associated app

Open Proctortrack || Cancel |

English  ~ ¢ Log Out

2. Follow the instructions on your screen.

Click the button below to download Proctortrack.

( Download Proctortrack )

Open

©

Click below if application is not connected in 49 second(s).

Technical Safety BC Contact Centre
1 866 566 7233
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3. Check the consent box and click Start System Check.

Agreement to Policy

If you are curious: about how Proctortrack works and how we
use your data Click here to leam more

Agreement to Policy

This test sponsor uses a third party vendor, Verificient
Technologies Inc, to perform remote 1D verification and
proctoring services. By checking this box: (1) | agree to
Verificient’s Terms of Service and acknowledge that Verificient
processes my personal data in accordance with its Privacy Policy
and (2) | consent to Verificient collecting, processing, and storing
my biometric data for the purpose of verifying my identity on
behalf of This test sponsor and the applicable member
institution as test sponsers as described in its Privacy Policy ,
which also explains how to revoke this consent.

All exam session are recorded by Verificient as outlined in its
Brivacy Policy

Proctotrack Test Instructor

| confirm my consent, agreement, and acknowledgment as

described above

| agree

4. The System Check will evaluate your hardware and software set-up. You will
receive pop-up prompts to change settings on your computer, if required. Follow
the prompts until the System Check completes successfully.

HARDDRIVE

System Check

Please wait while we check your system.

1 866 566 7233
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Verifying your identification and room scan on exam day (with your computer
and the ProctorTrack Smart Phone App)

1. To confirm your identify on exam day, you will be asked to complete a face scan.
Make sure to fill the frame before clicking “START SCAN". After that, follow the
on-screen prompts. You also have an option to retake the scan or click on “Next”
to continue.

=3 LOOK RIGHT

2. To confirm your identify, you will be asked to complete an ID scan. Read the
instructions and click “Start Scan”. You can also change the orientation of your ID
by clicking on “Rotate ID Outline”. Compare your ID scan with an example image
and click on the “Next” button if everything looks right. If there is any ID scanning
issue, click on the “Retake” button and scan the ID again.

HOLD ID STILL

Technical Safety BC Contact Centre
1 866 566 7233
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3. You will be required to conduct a room scan using the Proctortrack mobile app.

Room Scan

Room Scan

Your institution requires a Room Scan using the Proctortrack mobile app
Please CLEAR your immediate area for a successful room scan.

Step 1
Download the Proctortrack Mabile App

If you haven't already downloaded the Proctortrack Mobile App, visit
proctortrack.com/mobileapp on your phone or visit your App Store

=3 C

Step 2

Launch the Proctortrack mobile app.
Scan the QR code using the mobile app.

Follow the mobile app directions to produce a 360 degree scan of your room

Upon a successful room scan completion this page will automatically forward
to the next step.

4. On your smart phone, you will be guided through several verification,
identification and room scan processes. Follow the prompts on your
phone. Once you have completed all the steps, refer back to your
computer to begin your exam.

233
Agreement to policy System Check
Agreement Palicy Scan the QR code shown on the desktop App.
I hereby provide Verificien Technelogies
Inc. the permission 1o collect, process and

store my biometric data for the sole
purpose of verifying my identity.

Identity Verification

1 866 566 7233
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2:34

-_—
automatically. In case, i
‘seconds,click on End

oo st s competd s o
4 Poconng 05

End Proctoring

IMPORTANT: You must use a smart phone for the identification and room scan portion of the
authentication process.

Technical Safety BC Contact Centre
1 866 566 7233



TECHNICAL SAFETYBC

Launching the exam

1. Review the exam guidelines once more to ensure you are ready to begin. Then,

click “START PROCTORING”.

TEST GUIDELINES

Carefully review the guidelines listed below to learn what you can and cannot do during the test session.

Not Allowed

Allowed

° You will be allowed to copy-paste any content

o You will be not allowed to read from physical books ° You will be not allowed to read from physical books

Tips For Exam

!l :

START PROCTORING

Use a Private Agent Sit Directly in Front of Create the Proper Lighting

Turn O Noise-Making

NOTE: Test guidelines will vary based on your exam. Be sure to carefully review the

exam rules provided to you by Technical Safety BC.

2. You will now be able to see yourself on the camera at the bottom right side of your screen.

Click “COPY ACCESS CODE” to copy the password.

Anoop Prabhakaran (username: Verificient.53)

Quiz Periad
Availablle on Apr 1, 2017 4:52 AM until Apr 30, 2022 8:52 AM

Time Allowred

Unlimited (estimated time required: 2:00:00)

Attempts

Allowed - Unlimited, Completed - 4

Instructions

You can submit your quiz responses at any time.

Click "Start Quiz" to begin Attempt 5

Quiz Requirements
A password is required to start your attempt.

Quiz password:

Start Quiz!

Proctartrack (15).pka
.

Before you submit the quiz, you will have the opportunity to return to questions that you may have missed or have not yet answered.

[ copy AccEss CooE |

& K

3. Paste the quiz password as shown below in the empty field and click on “Start Quiz”.

4. You may now take your exam. Good luck!

1 866 566 7233
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Asking for help and finishing your exam

1. If you need support while using Proctortrack, you have the option to interact with
support staff through the live chat feature. When you have answered all the
exam questions, click the “END” button.

Exim Pamswcrd: 123455 —_
& S -

Hi. my app crashed, could you pleasa help ma
understand what's hegpening?

(CTRE T
| 2m soey o heae that, have sou tried
rakuncking the anp?

Aamir Joe 1-30PM

2. To confirm that you have completed your exam, click the “END” button near the
middle of your screen.

End Proctoring

Are you sure you want to end Proctoring?

Continuing the exam without monitoring may result in
disqualification, low and/or failing grade.

1 866 566 7233
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3. Your test session will be automatically uploaded to Proctortrack within a few
seconds

Uploading.
Do not quit the app.

The time it takes to upload the data would depend on
your internet speed

4. Once the upload finishes, your test session is complete! Both the buttons visible
here will close Proctortrack. Click “QUIT” to save the application for use with later
tests, or click “UNINSTALL” to remove Proctortrack from your computer. We
recommend you uninstall Proctortrack after your exam session.

Upload Completed!

Upload Successful! You May now quit the app.

1 866 566 7233
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5. Close the app by clicking End Proctoring.

When the test is complated this app will close.
automatically. In case, it's taking longer than few
seconds, click on End Proctoring to close it manually,

End Proctoring

Technical Safety BC Contact Centre
1 866 566 7233



